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1 Introduction 

This document describes the layout and use of the Compano Online Software graphical user 
interface, as well as its basic functions. 

1.1 Concepts 

COS 
Compano Online Software application. Version of the COS-application are, for instance K05, L02, 
L03, etc. 
 
PIM 
Product Information Management system, used to manage product and item data. Data can be 
communicated to data pools, product websites, catalogues, web shops, etc. 
 
Shared application 
Your own COS-environment, which shares a database and application with other Compano 
customers. 
 
Dedicated application 
Your own COS-environment, database and COS-application; mandatory for additional licenses 
such user-defined fields. 
 
Entity 
Data object in COS, for instance Product, Item, Assortment, Attachment, Price, etc. For most entities 
in COS an overview has been created. 
 
Record 
One instance of a data object in COS, for instance one product or one item. 
 
Overview 
Overview of all records of a data object. A default screen layout has been defined for each 
overview. 
 
Data field 
One field containing data, such as a price in Euros, Diameter in millimetres, etc. 
 
Import 
Import of data into data fields in COS. 
The data source is often an Excel or text-based data file, but could also be a data file which makes 
use of (international) standard exchange standard, such as DICO (INSBOU/SALES), BMEcat, FAB-
DIS, etc. 
 
Export 
Export of data out of data fields in COS. 
The export is often an Excel or text-based file. but could also be a data file which makes use of 
(international) standard exchange standard, such as DICO (INSBOU/SALES), BMEcat, FAB-DIS, etc. 
 
Standard exchange format 
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Several standard formats have been defined to exchange data for the construction and 
engineering sector, for example: PAB, DICO/SALES, BMEcat, FAB-DIS. These Data Exchange 
Standards facilitate the sharing of structured data across different information systems. 
 
Screen layout 
Layout of data columns (fields) on an Overview in COS. Layouts can be customized by the user and 
often serve as a mapping for data exports as well. 
 
Import layout 
Layout for importing data into of COS. Import layouts can be customized by the user. 
 
Export layout 
Layout for exporting data out of COS. Export layouts can be customized by the user. 
 
Delta import 
A Delta Import compares data in the source file with data in COS. On import only new or changed 
data is imported. 
 
Full import 
A Full Import compares data in the source file with data in COS. All data in COS is overwritten with 
data from the import file. 

1.2 Product versus Item 

Product 
A product is a manufactured and often branded object which can be described in technical terms. 
 
Item 
An item is a (collection of) product(s) which are packaged and priced. An item can be described in 
logistical terms. 
 
Product group 
Product groups are used to group a set of products that share the same information, such as a 
photo, drawing, etc. 
 
Item group 
Item groups are used to group a set of items that share the same information, such as assembly 
manual, energy label, etc. 
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2 Login 

Compano offers its software as a service (SAAS). COS is in essence an online database which can be 
manipulated through a web browser. 
 
A Compano consultant will have granted you access to your COS application. You should have 
received an e-mail containing a login link, user name and password. 
 
Did you not receive an e-mail? 
Please contact Compano Support at support@compano.com, or call +31 88 266 7 202. 

2.1 Which browser to use? 

Compano software is browser-independent, so you are free to use any of the commonly available 
web browsers. However, Compano recommends to either use the latest version of the Microsoft 

 

2.2 Shared application 

To log into a shared application, use the following URL: 
 
https://pim.compano.com  
 
Once you have entered your user name and password, you will be directed to your system 
environment: 

 

2.3 Dedicated application 

To log into a dedicated application, use this URL: 
 
https://[your_company_name].compano.com 

mailto:support@compano.com
https://pim.compano.com/


 

11 
 

2.4 Prerelease environment 

- prerelease 
environment: 
 
For a shared environment: https://pimprerelease.compano.com 
 
For a dedicated environment: https://[compano_name]test.compano.com 
 
Note: You will need a separate prerelease-account to login; please ask our Support department for 
your login credentials should you need them. 

2.5 Login timeout 

As a security measure, you will be automatically logged out after 60 minutes of inactivity. 

3 Navigation 

Once you are logged in, you will be presented with the Compano graphical user interface which 
consists of: 
 

• Menu (main menu) 

• Overview (overview of product, items or other data) 

• Side panels (left and right) 

 

3.1 Main menu 

The main menu contains the navigation buttons to the main components of the application: 
 

• Contacts: Address and other data of users, manufacturers and suppliers. 

• Products: Access to product overview, manufacturers, classification data and more. 
• Items: Access to item overview, suppliers, assortments, price information and more. 
• DAM: Digital Asset Management; management and overview of Attachments and 

Certificates. 
• Publications (optional): Access to publication structures. 

https://pimprerelease.compano.com/
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• Classification: Overview of the latest ETIM standard (ETIM dynamic). 
• System: System configuration, logs and users. 

• My Details: Change user details, company settings, screen settings. 

• Help: Access to main Help website, support, release notes and system information. 
• Logout: Log out option to terminate login session. 

 
For more information on the main menu choice see chapter: 4. Main menu. 

3.2 Submenu tabs 

Once you make a choice in the main menu, you will be presented with several tabs, each with its 
own submenu with functions. 
 
For example, if you choose Products from the main menu, the submenu functions on the tab View, 
such as Filter, Search, Select, Details, Screen Layout will perform their action on the product records 
which are visible in the overview: 

 
Once you switch to the Edit tab, different functions become available, such as Search, Add, Modify, 
Delete record(s), Line edit on, Copy), for changing or modifying data of product records: 

 

Note: The menu options from the Edit, Functions and Print tab are also available 
in the left side panel. 
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3.2.1 View 

The View tab contains the options: 

 
• Filter: Filter records in the overview, using one or a combinations of data fields. 
• Search: Find all records containing a text string. 
• All/Deselect Select all / deselect all active records in the current overview. 

• Details: Show all data fields of the record which contain data in a pop-up window: 

 
o Show previous and Show next: Use these buttons to leaf through the records in the 

Overview. 
o Modify: Use this button to directly change any data field. 

• Screen Layout: Select a screen layout. 

3.2.2 Edit 

The Edit tab contains the options: 

 
• Filter: Filter records in the overview, using one or a combinations of data fields. 
• Search: Find all records containing a text string. 
• Add: Add a new record. 
• Modify: Modify the selected record. 

• Delete record(s): Delete the selected record(s). 
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• Line edit on/off: Set Line Edit to On; you can now edit data of a record directly in the 
overview. 

• Copy / Paste: First copy then paste the record. 

3.2.3 Functions 

The options under Functions differ according to the main menu selection. 
 
For instance, the options for Products are Manipulate, and (Add) Part: 

 
The functions for Assortment are: Transfer (to) Artikelbeheer, Transfer 2BA, Transfer Fesah, Quality 
Control, Update and (Add) Purchasing contract: 

 

3.2.4 Print 

The Print tab contains several options for printing. Which options are available depends on the 
type of overview. 
 
Options include: 

• Search: find all records containing a text string. 
• Product sheet: print a product sheet containing basic product information, product image 

and drawing, a barcode and the product class and corresponding features of a product 
• Product class: print the product class and features of a record. 

• Printing options: print either the product class or (overview) list of records, optional: select 
a printing layout. 

• Managing Product class / List layouts: manage (add, edit, delete, copy) a print layout for 
printing of a product class of list of record(s). 

3.2.5 Import / Export 

The Import / Export tab contains several options for importing and exporting data. Which options 
are available depends on the type of overview: 
 
Options include: 

• Search: find all records containing a text string. 
• Export [entity]: export (filtered/selected) records using either the screen layout or a 

predefined layout. 

• Import: import data / records using a predefined layout and import file. 
• Item exports: export (filtered/selected) records using an industry format, such as 

DICO/SALES, BMEcat, FAB-DIS, etc. 
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• Export images: export images of (filtered/selected) records. Images will be sent to an 
FTPS-location on the Compano server where they can be downloaded1. 

• Export classification: export all current classification data of products in COS. 
• Report export attachments: generates a report listing all attachments for all products, 

product groups, items and item groups. 

3.3 Side panel navigation 

Additional navigation and functional options are By 
default the side panels are disabled to allow for maximum screen space for product or item data. 
To enable the side panels: 
 

1. Through to Menu go to My details > My settings: 

 
2. Under Screen Settings set the option for Left panel display and Right panel display to Yes 

and click on Close: 

 
3. Next, through the main menu, go back to My details and click on Activate Screen Settings: 

 

 
1 You should have received FTPS-account login details from your Compano consultant. For FTPS download, Compano 
recommends the freely available FTP-software FileZilla. 

https://filezilla-project.org/
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The screen settings have now been activated, which means the side panels will show on every 
overview in COS 
 
Note: COS remembers screen settings per user and per browser window resolution. Should you 
change the size of your browser window, you will have to re-activate them. 

3.3.1 Related navigation 

Data of one record in COS can be related to other records. For instance, a product record is related 
to a corresponding item record and this item record is related to a gross price record, attachments 
records, surcharge records, etc. 
 
Therefore, data in COS can be navigated by following these relations to other data. In practice this 
will allow you to select a product, item, price, or other data record and navigate to any related data 
record. 
 
Relational navigation is available in the top left side panel. For instance: 
 

1. Through the Menu, go to Items. 
2. Select an item and in the left side panel, under Navigation, links to related data are shown: 
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In the example above, you can navigate to Product parts (1/0) of the selected item, 

Attachments (74/0), three Items (3/0)and the corresponding Product 
group: E_TS LED. 
 
Note: Numbers in parenthesis indicate how many related active records are available. 
Numbers after the forward-slash indicate the number of archived records: 

 

3.3.2 Submenu options 

The menu options from the Edit, Functions and Print tabs are also available in the left side panel. 
For example: 

 

3.4 Back button 

Note: As the navigational history of the application can differ from browser history always use the 

green arrow back button to return to the previous screen: 

 



 

18 
 

4 Main menu 

The main menu contains the main navigation for the application: 

 

4.1 Contacts 

In Contacts you will find the name, address and other data of organisations or persons which are 
used in the application. For instance, your company, users of the PIM software, et. Cetera. 

 
Note: For a PIM implementation, you will often only find your own 
the application users. 

4.2 Products 

Under Products you can View/Edit: 

 
Manufacturers: One or more manufacturers of your 

 
Product  Product relations: Set relations between products, such as product parts, accessories, 
optional products, or set the predecessor and successor relations. 
Product classifications: An overview of all your products, including all product classification data. 
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Product groups: An overview of all product groups which are in use. 
Product Search: A quick, searchable overview of all your products. Note: This menu option is for 
Compano Artikelbeheer.nl customers only. Compano PIM customers can use the search box on the 
Product overview instead. 
Products: An overview of all products, including extended edit functions. 

4.3 Items 

Under Items you can View/Edit: 

 
Assortment: One or more collections of your items. For instance, all item for the Belgian market 
and all items for the UK market. 
Item  Item relations: Set relations between items, such as item accessories, alternatives and 
optional items, or set the predecessor and successor relations. 
Incidental export: Pre-defined exports of item data. 
Item groups: An overview of all item groups which are in use. 
Items: An overview of all items, including extended edit functions 
Price Information: An overview of the price history of all items 
Item Search: A quick, searchable overview of all your items. Note: This menu option is for 
Compano Artikelbeheer.nl customers only. Compano PIM customers can use the search box on the 
Item overview instead. 
Suppliers: An overview of all suppliers. 
Surcharges: An overview of all surcharges which are applicable to you items. 

4.4 Publications 

Publications determine the way information is structured for exchange with (external) application 
using the XML feed format. 
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4.5 DAM 

DAM stands for Digital Asset Management. This is a placeholder for the planned Compano DAM 
system, to better manage your attachments. 

 

4.5.1 Attachments 

Currently, only an overview of all your attachments is available. 

4.5.2 Certificates 

This option allows for the addition of certificates and linking them to multiple products. Certificate 
information is shared using the DICO/SALES, BMEcat 5.0 and DQR industry formats. 

4.6 ETIM 

The ETIM menu option, provides an overview of the latest ETIM classification: 
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Note: ETIM is a dynamic classification system, which means it is updated each Sunday. 

4.7 System 

Under System you will find: 

 
Background tasks: Larger imports and exports take time; in Background tasks the overview will 
show how many tasks are still running, including an indication by which time they will be finished. 
The interface also allows for stopping background tasks which are in progress. 
Configuration: Configuration holds all the configurable options of COS, such as which languages 
to use, periodic tasks, conversion tables and much more. Configuration is usually the domain of 
your application manager or the Compano consultant. 
Environments (optional): If your application controls several, different (sub)environments, access 
to these is through this menu option. 
Layouts: Overview of all layouts, including feed, import, export and screen layouts. Layouts can be 
prepared through this menu option. 
Logs: Logs will show an overview of all changes to the data made by system users. Note: you can 
also find and download system reports under Logs. 
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User-defined fields (main) (optional): If you need extra data fields beyond the standard fields, you 
can manage them here. Only available if you have a dedicated application. 
User groups (optional): With the option user groups you can set access levels per group (f.i. view 
only, data manager, etc.) and assign users to them. 
Users: System users have access to the data and, depending on user rights, can view, edit and/or 
delete information. 

4.8 My details 

My details can be used to change user details and settings: 

 
My details: Change contact information, user interface language, e-mail address, and more. 
Change password: Reset your password. 
My AB subscription (optional): Manage your subscription to Artikelbeheer.nl. 
Company settings: Configurable PIM options for your company, such as classification system, 
price system, default import/export settings, default language, default country, number formats 
and more. 
My settings: Screen settings (left and/or right sidepanel). 
Activate screen: Activate screen settings. 
Homepage: Set your homepage within Compano PIM. 

4.9 Help 

Under Help you will find: 

 
Help webpage for downloading manuals, Excel templates and the Microsoft 
Office Add-in. 
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Support: Access your support tickets to view their status. 
Release Notes: Read the latest release notes which include changes to application functionality. 
Ticket: Add a support ticket concerning a wish, error or question. 
Info: Find information on your software version and how to contact Compano Support. 

4.10 Logout 

Use this menu option to log out. Alternatively, you can close the browser or browser tab in which 
the application is shown. 

 

5 View 

Once you make a choice in the main menu, the application will switch to the View tab, which will 
give you the option to search for, view and select one or more data records: 

 

5.1 Filter 

The preferred way to find one or more records is to use the comprehensive Filter: 

 

5.1.1 Apply a filter 

To apply a filter: 
 

1. Click on the Filter button (1) 
2. In the pop-up window use any number of data fields (2) to set filter parameters. 

 
Note: You can combine any number of data fields on any of the tabs: 
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3. Click on Apply (3) to activate the filter. 

5.1.2 Filter options 

5.1.2.1 Text filter options 

For data fields which contain an alpha-numeric text value, these options are available: 

 
• Contains word: Filters records with text containing filled out word, or words. Also filters on 

part of a single word. 
• Start: Filters records with text starting with filled out word, or words. Also filters on part of 

a single word. 
• Filled: Filters records where this text field contains a value 

• Empty: Filters records where this text field contains no value 
• Automatic: Filters records where the text field is set to be filled automatically; i.e. inheriting 

data from another data field. 

5.1.2.2 Number filter options 

For data fields which contain a number value, these options are available: 
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• = value: Filters records where the data field value is equal to the filled out value. 
• : Filters records where the data field value is not equal to the filled out value. 

• > value: Filters records where the data field value is greater than to the filled out value. 
• < value: Filters records where the data field value is smaller than to the filled out value. 
•  Filters records where the data field value is greater than or equal to the filled out 

value. 
• : Filters records where the data field value is smaller than or equal to the filled out 

value. 
• Between: Filters records where the data field value is between the filled out values. 
• Outside: Filters records where the data field value is outside the filled out values. 

5.1.2.3 Date field options 

For data fields containing a date, the following extra options are available: 

 
• Past: Filters records where the date lies in the past (counting as of today). 
• Last month: Filters records where the date is within the last 30 days (counting as of today). 
• Last week: Filters records where the date is within the last 7 days (counting as of today). 
• Today: Filters records where the date is  
• Next week: Filters records where the date is within the next 7 days (counting as of today). 

• Next month: Filters records where the date is withing the next 30 days (counting as of 
today). 

• Future: Filters records where the date lies in the future (counting as of today). 

5.1.2.4 Other options 

For other types of data fields a number of other option might be available, including: 
 

• Contains: Filters records where the data field value contains the filled out value. 

• Contains not: Filters records where the data field value does not contain the filled out 
value. 

• Ends with: Filters records where the data field value ends with the filled out value. 
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• Has [entity]: Filters records that are linked to records of the specified entity. For instance: 
The product has linked items. 

• Has not [entity]: Filters records that are not linked to records of the specified entity. For 
instance: The product has no linked items. 

• Has archived [entity]: Filters records that are linked to archived records of the specified 
entity. 

• Has unarchived [entity]: Filters records that are linked to unarchived records of the 
specified entity. 

• Has no unarchived [entity]: Filters records that has no linked unarchived records of the 
specified entity. 

5.1.3 Save a filter 

If you need to save a filter for future use: 
 

1. Click on the Save as button in the pop-up window: 

 
2. In the new pop-up window set a name for your filter and choose whether it will be 

available only to you, or to all Compano users within your company: 

 
3. Click on the Save button. 
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Note: The filter will be available in the Filter menu once you have refreshed your browser with 
CTRL-F5. 

5.1.4 Use a saved filter 

To access the savedfilter menu, use the down-arrow next to the filter button. This will display a list 
of saved filters, including your own filter: 

 

5.1.5 Edit a filter 

To manage saved filters, use the Manage filter option in the filter menu: 

 
This option will show a list of saved filters which you can edit, copy/paste or delete, using the 
buttons in the Edit menu: 
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5.1.6 Clear a filter 

Once you have applied a filter, a warning message will alert you that a filter is active: 

 
Hovering over this message will show a tooltip listing all filter parameters that were set. 
 
To clear a filter: 
 

1. Click on the filter button 
2. In the pop-window, click on either: 

a. Empty: This will reset all filter parameters so you start the filter process anew 
b. or Empty and close: This will reset all filter parameter and close the filter window 

 

5.1.7 Archived records 

Archived records will not show in the Overview as this will only display active records. To display 
archived records, select the filter option Including archive: 

 
If you screen layout contains the data column Archived, this 
next to any archived records. 
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Important: As of software version L03 the data field Mutation Code, which was 
also used to indicate archived records, has been deprecated. On your layouts this 
field should be replaced with the Archived field. 

5.1.7.1 Additional filter options on archived records 

Should you need to filter on archived records with additional filter options, follow the steps below: 
 

1. First, filter your products/items using the Include archive filter option: 

 
2. Tip: Sort on the  
3. Next, click on the Include archive button again to set any additional filter options. For 

instance, with product code equal to 500012000300: 

 
4. This will display the archived record with the product code 500012000300: 

 
Note: While the overview will show records, including archived ones, the Filter button will reset to 
Filter . 
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5.2 Quick filter 

The right side panel contains a Quick Filter. With this filter you can make quick selections of 
records, based on information available in your application. 
 
The quick filter is updated each night, so any information that you add today will be available for 
filtering the next day. 
 
The quick filter is a cascading filter, which means that you will be presented with further choices 
once you make a selection. For example, selecting Valves will give you a new choice to select the 
Type of valve: 

 
To reset the quick filter, use the Clear Selection button: 

 

5.3 Search 

Optionally, filter results can be refined by using the Search box. Type any number of search terms 
to narrow down the number of results of a filter. As of the first three characters typed, the search 
box will suggest available search term options: 
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Note: Search will search through all data fields for a match. This way, you will often get unexpected 
search results or find several matching records which are not the same thing, for instance a 
sealing wax and a valve sealing ring. 

5.4 Select 

To select a record, click on the line in the overview. The selected record will display as a grey line. 
Use SHIFT- and CTRL-click to select multiple records. Use the arrow-keys to extend your selection: 

 
Note: To select records, do not click on any links in the Overview as this will open an information 
window instead. 

5.5 Details 

To view the details of a record, either click on the Detail button or on the link displayed on the 
overview: 
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Detailed information on the selected record will show in a pop-up window with several tabs. To 
view tabs that are out of view, use the scroll button: 
 

 

5.6 Screen layout 

The Screen Layout determines which data fields are visible on the Overview. As not all available 
information of a record fits into one window, the application allows for several, different layouts, 
which can be tailored to your needs. 

5.6.1 Default layout 

For each data overview in COS a default layout is available. This default layout will show the most 
common data fields for that screen. 
 
Once you have added other screen layouts of your own design, the default layout will be available 
as selection option in the Screen Layout menu: 

 

5.6.2 Datapool layouts (PIM-customers only) 

In addition to the default layout, Compano offers screen layouts tailored to the specific needs of 
PIM-customers. These layouts offer an overview the most relevant data fields for data pools such as 
2BA, InstallData and others. Datapool-branded2 layouts are available for the following overviews: 
 

• Products 
• Items 

 
2 Depending your application version, these layouts are called either Datapool or Compano. Datapool layouts 
include the Short description field for both Products and Items and are thus SALES005-ready. 
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5.6.3 Custom layout 

To add a custom layout or your own design: 
 

1. Navigate to the Overview where you need to add a screen layout. 
2. On the View tab, go to Screen Layout > Manage Screen: 

 
3. On the next screen, +Add new layout: 

 
4. In the pop-up screen: 

 
Layout tab 

a. Type: Type of layout (automatic). 
b. Name: Type a name for your layout. This name will show in the drop-down 

selection menu. 
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c. Application: Choose whether the layout will be available only for you, or for 
anyone within your company. 

Fields tab 
On the Fields tab you will find two field lists next to each other: 

a. Available fields: Lists data fields that can be added to your layout, organised in 
four different ways (All fields, Alphabetically, By category, Standard fields). 

b. Selected fields: Lists the data fields that are currently in your screen layout. Note: 
by default, a new layout will contain the standard fields for the overview. These 
standard fields can be removed/reordered as fits your needs: 

 

5.6.3.1 Adding/removing data fields 

To add or remove data fields to/from the screen layout: 
 

1. Either double-click the field, or use the left/right arrow buttons, to add/remove fields from 
one list to the other. Note: you cannot add/remove multiple fields at the same time. 

2. When adding a field, first find the field in the Available fields window. To find the right 
field, searching by category is recommended: 

 
Note: By extending All fields, the CTRL-F search option of the browser can be used to 
quickly find a data field: 
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3. By default, fields will be added at the bottom of the Selected fields list. To add a field at a 

specific position in your layout, select a line in the Selected fields list, then add the new 
field. The field will be added above the line you selected: 

 
4. To remove data fields, simply double-click any unwanted fields in the Selected Fields list or 

move them to the left with the arrow button: 
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5.6.3.2 Reorder fields 

To reorder a field in the Selected fields window, select a line and use the up/down arrows : 

 

5.6.3.3 Customize layout properties 

You can customize each data field in your layout in the Properties window: 
 

1. Select the field which properties you need to customize 
2. In the Properties window change one or more data field properties3, such as: 

a. Header: To change the header text of the data column, first uncheck Automatic 
tick box, then type a new header text. 

b. Column width: Select a column width option: 

 
3 Which properties are available will depend on the type of data field. 
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i. Standard: This is the default setting. 
ii. Automatic: The column width will be matched to the data entry with the 

most characters. 
iii. Fill out: All data fields marked with the Fill out option, will be divided over 

the available screen space. 
iv. <enter a value, eg50>: Enter a number of pixels to be used for the data 

field. Use this option if you need to fine-tune your screen layout. 
c. Other  

 

5.6.3.4 Sorting 

The sorting of records in your layout can be set on the Sorting tab: 
 

1. Switch to the Sorting tab 
2. Add fields from the Available fields window to the Selected fields window. Note: in this 

example records will first be ordered on Condition Group Code, and within each code 
on Item number: 
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5.6.3.5 Quick filter 

The Quick Filter tab will always show the default quick filter options. If you need to filter on other 
fields, add them from the Available fields window: 

 

5.6.3.6 Save a layout 

Once you are satisfied with your layout, click on the Save button: 

 

5.6.4 Activate a layout 

Once you have saved the layout, you will return to the overview of layouts. To activate your new 
layout, click on Apply under Functions: 

 
Alternatively, you can select your layout on the View tab of your screen, using the Screen Layout 
button: 
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5.6.5 Edit / Copy / Delete layout 

To edit or delete a custom layout, click on the Screen Layout button and select Manage Screen 
layouts. Under Edit you can either Modify, Copy or Delete a layout. 

When you need a slightly different variant of a layout, use the Copy and Paste 
buttons to quickly copy an existing layout. Then use the Modify button to change 
the copied layout to your needs. 

6 Edit 

To add, modify, delete, or copy/paste a record, on any screen go to the Edit tab: 

 
Or, in the left side panel, select an option under Edit:  
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6.1 Add 

To add a record, for example a product: 
 

1. Click on +Add 
2. Enter the required information. For a product this would be: 

a. Manufacturer: Choose a manufacturer from the drop-down menu 
b. Code: Enter a product code 
c. Product description: Enter a description 
d. Etc. 

3. Check if any fields on any of the other tabs needs to filled in. 

 
4. Save the new record. 

 
Note: Adding multiple records manually is a time-consuming task. Multiple records are usually 
added by importing data from an Excel file. 

6.2 Modify 

To modify any data field of a record: 
 

1. On any overview, select a record and click on Modify 
2. In the pop-up window, change any of the data fields on any of the data tabs 
3. Click on Save, to save your changes. 
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6.3 Archive / Delete 

Deleting an active record within COS is a two-step process: 
 

• First, a record is archived; 
• Next, the archived record can be deleted4 (permanently). 

 
The Archive Status of a record is handled by the data field Archived5: 

 
On screen layouts, an archived record is indicated by a file cabinet icon in the Archived column. 

filter option Including archive: 
 

 
4 Important: Deleting an archived record is an irreversible action. Should you need to retrieve accidentally 
deleted records, you will have to contact Compano Support and have them restore a backup of your data. 
5 In previous versions of COS, the field Mutation Code (MC) was used to indicate the Archived status. Note: 
This field has been deprecated. 
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6.3.1 Archive a record 

To archive any record: 
 

1. On any overview, select a record(s) and click on Delete record(s) 
2. A pop-up window will display the following message: 

 
3. Click on OK to archive the record. 

 
Note: For PIM applications archived records are kept for 2 years. After 2 years, the archived data will 
no longer be loaded into your application, which means it is no longer visible in your PIM 
application. However, the data is still available in your database and can be loaded on request. 
Should you wish so, please contact Compano support. 
 

6.3.2 Modify archived records 

Archived records cannot be modified, unless they are first unarchived. Thus, if you need to modify 
an archived record, you first can do so by unarchiving the record, modify it and then again archived 
it. 
 
To unarchive a record, see 7.1.2 From archive. 
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6.3.3 Unarchive a record 

To unarchive a record, see 7.1.2 From archive. 

6.3.4 Delete a record 

To permanently delete a record(s): 
 

1. On any overview, first check if the record you want to delete has been archived. 
a. Either check for a recycle icon in the Archived column (X) 

 
2. Select the archive record(s) and click on Delete record(s) 
3. A pop-up window will display the following message: 

 
4. Only click OK if you are really sure you want to permanently delete the record. 

6.3.5 Using import to archive / restore records 

The Archive Status of a record can also be changed using an import file. The import file should 
contain a data column labelled Archived, where the archive status can either be set to Yes (record 
is archived) or No (record is not archived): 

 

6.3.5.1 Archive products/items on import 

For the import of Products and Items only, an alternative archiving option is available: 
 
In the Import dialog the option Archive not imported records can be set to Yes. Any Products (or 
Items) which are present in the COS database, but are no longer offered as a record in the Import 
file (Excel or text-based), will be archived. 
 
Important: The Archive not imported records will only be available when an Import layout is 
selected that contains the key data fields for the entity Product or Item. 
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Note: Archiving of products/items using the Archive not imported records will also function 
when the layout is used for a Periodic Import Task. 

6.4 Line edit 

Using the Line edit function, data fields can be edited directly in the Overview. This method is 
particularly useful to make quick correction to your data: 
 

1. Under Edit, click on Line edit on to active line editing: 

 
2. In the Overview, click on any of the data fields to edit it: 

 
Note: User-defined fields cannot be edited using line edit. 
 
Important: Set Line Edit to Off, once you have finished editing. 
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6.5 Copy / Paste 

To copy a record: 
 

1. On any overview, select the record you want to copy and, under Edit, click on Copy: 

 
2. Next, under Edit, select Paste from the Copy menu 

 

 
Note: The copy/paste function is well-suited for copying products, layouts or filters, but will return 
an error message when you try to copy an item, product group or item group. The reason being 
that item-, and group codes cannot be copied as they need to be unique. 

6.5.1 Copying products 

Products can be copied while retaining all product data, including classification, provided a 
product number template has been defined. 
 
A product number for the new product will be generated, based on the Product number template. 
The Product number template can be set at the Manufacturer settings: 

 
Note: The #-character can be used as a wildcard in the template. For instance, if you have two 
product number variants, NA-0000 and RX-0000, then the product number template should be 
##-0000; thus products with both number variants can be copied. 
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6.6 Edit multiple records 

To edit multiple records, see the function 7.1.1 Manipulate 

7 Functions 

Functions are specific to the Entity on which they have an effect. Thus, for instance, functions for 
Products differ from those for Items. Please see the next paragraphs for functions related to each 
entity. 
 
Note: Depending on your software license, some functions might not be available. 

7.1 Common functions 

Two functions are common to all entities within the application: 
 

• Manipulate: Change data of one or more data fields for multiple records; 
• From archive: Change the status of a record from Archived to Unarchived. 

7.1.1 Manipulate 

Change the data of multiple records at the same time, using the function Manipulate . 
 
For example, should you want to change the value of Type for multiple products: 
 

1. Select the products you wish to change and, under Functions, click on Manipulate: 

 
2. For any data field where you want to make a change, set the action to Grant and change 

the value of the data field: 
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3. Click on Apply to save the changes. 

7.1.2 From archive 

To unarchive a record: 
 

1. On any overview, on the View tab, first select the Including archive filter option: 

 
2. Alternatively, click on Filter and, on the Additional tab, set Archive moment to filled, or 

choose an appropriate archive date: 
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3. Next, select any archived record(s) and, under Functions, click on From archive: 

 
4. The Archive Status of the record(s) will now be set to No. 

7.2 Products 

 

7.2.1 Generate product sheet 

The Generate product sheet function generates product sheets for all selected products. More 
information can be found in paragraph 8.2 GENERATE PRODUCT SHEETS. 
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7.3 Product classifications 

 

7.3.1 Copy classification 

With the Copy classification function, classification data can be copied from one classification 
system to another, for example: from ETIM Dynamic to ETIM 9. 
 
More information is available in the Manual Multi-Model Classification, which is available from the 
Compano Help-website. 

7.3.2 MC Viewer 

With the MC Viewer function ETIM Model data can be viewed and/or modified. 
 
More information is available in the Manual ETIM MC Viewer, which is available from the Compano 
Help-website. 

7.4 Assortment 

 

7.4.1 Transfer with scheme 

For some set-ups, Assortments can be transferred using an Extract, Transfer, Load scheme. This 
option is usually available for MDM-configurations of the Compano software. 
 
More information is available in the Handleiding overzetregels, which is available from the 
Compano Help-website. 

7.4.2 Transfer AB 

Transfer data to the Artikelbeheer.nl data pool. 
 
More information is available in the Manual Publishing on Data Pools, which is available from the 
Compano Help-website. 

7.4.3 Transfer 2BA 

Transfer data to the Dutch 2BA data pool. 
 
More information is available in the Manual Publishing on Data Pools, which is available from the 
Compano Help-website. 

https://help.compano.nl/compano-manuals/Manuals-l.html
https://help.compano.nl/compano-manuals/Manuals-l.html
https://help.compano.nl/compano-manuals/Manuals-l.html
https://help.compano.nl/compano-manuals/Manuals-l.html
https://help.compano.nl/compano-manuals/Manuals-l.html
https://help.compano.nl/compano-manuals/Manuals-l.html
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7.4.4 Transfer InstallData 

Transfer data to the Belgian InstallData data pool. 
 
More information is available in the Manual Publishing on Data Pools, which is available from the 
Compano Help-website. 

7.4.5 Quality Control 

Use the Quality Control function to check the quality of your Item data. 
 
Transfer data to the 2BA data pool. 
 
More information is available in the Manual Classification, which is available from the Compano 
Help-website. 

7.4.6 Update 

Use the Update function to update your Item data, for instance when data in the Purchase 
assortment has been changed. 
 
To update a sales assortment: 
 

1. Through the Menu, go to Items > Assortment: 

 
2. Select the sales assortment that is to be updated and, under Functions, click on Update: 

https://help.compano.nl/compano-manuals/Manuals-l.html
https://help.compano.nl/compano-manuals/Manuals-l.html?style=L04#pim
https://help.compano.nl/compano-manuals/Manuals-l.html?style=L04#pim
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3. In the pop-up window: 

 
a. Sales assortment: The selected sales assortment. 
b. Purchase assortment: The selected sales assortment will be updated with data 

from this purchase assortment. 
c. Price reference date: Select a price reference date; a (future) price date can be set 

to update prices in the sales assortment with the price valid at that date. 
d. Only check run: Set this option to Yes to only generate an update report 

indicating changes that will be made to the sales assortment. To actually execute 
the changes, set this option to No. 

4. Click on Execute. 

7.5 Items 

 

7.5.1 Generate item sheet 

The Generate product sheet function generates product sheets for all selected products. More 
information can be found in paragraph 8.3 GENERATE ITEM SHEETS. 
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7.5.2 Generate sales items 

Use this function on Purchase Items to generate corresponding Sales Items. The dialog allows the 
selection of the Sales Assortment where the Sales Items need to be generated. 

7.5.3 Update 

The Update function will update the following information of the selected items: 

 

7.6 Publications 

 

7.6.1 Export publication 

Export the selected publication: 
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• Email address: Send the export to this email address. 

7.6.2 Export Guideline 

Guideline is a database publisher based in Belgium. Using the Export Guideline function, an XML 
export including special formatting tags can be exported. 
 
More information is available in the Manual Publications, which is available from the Compano 
Help-website. 

7.6.3 Renumber 

When manually creating or editing a publication the sequence numbering of publication links can 
easily become corrupted, for instance when removing publication links. Use the Renumber 
function to correct the numbering of a publication. 
 
More information is available in the Manual Publications, which is available from the Compano 
Help-website. 

7.7 Product classes 

 

7.7.1 ICS Email impact analysis 

The function ICS Email impact analysis will generate a report of all changes in the ETIM Dynamic 
classification system since [date]. This information can be used to check the whether any changes 
need to be made to your classification. 
 
More information is available in the Manual Classification, which is available from the Compano 
Help-website. 

https://help.compano.nl/compano-manuals/Manuals-l.html
https://help.compano.nl/compano-manuals/Manuals-l.html
https://help.compano.nl/compano-manuals/Manuals-l.html
https://help.compano.nl/compano-manuals/Manuals-l.html
https://help.compano.nl/compano-manuals/Manuals-l.html
https://help.compano.nl/compano-manuals/Manuals-l.html
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7.8 Background tasks 

 

7.8.1 Refresh 

Use the function Refresh to update the status of running processes, for example a large import of 
new product and/or items. 

7.8.2 Stop 

Use the function Stop to cancel a running processes, for example a large import of new product 
and/or items. 

7.9 Layouts 

 

7.9.1 Test feed layout 

Use the Test feed layout function to generate an XML-file of the selected feed. 
 
Note: XML- and JSON-feed can also be tested using third-party software such as Postman. 

7.9.2 Standard 

Use the Standard function to set the selected layout as the standard report template layout for 
chosen entity. 
 
Note: Only relevant for report layouts. 

7.9.3 Scan 

Use the Scan function to scan for corrupt and invalid layouts A scan report will be generated, listing 
all layouts with invalid fields or any corrupt ayouts (InvalidLayouts.csv). The scan report is available 
via System > Logs and will also be sent to the user performing the scan. 
 
Note: Compano consultants will still have access to layouts that have been removed. 
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7.10 Users 

 

7.10.1 Login as 

Use the Login as function to log in as the selected user. 

7.10.2 Change Password 

Use the Change Password function to change the password for the selected user. 

7.10.3 Send Password 

Use the Send Password function to send the password to the selected user. 

7.10.4 Create Administrator 

Use the Create Administrator function to grant Administrator rights to the selected user. 

8 Print 

A record or list of records can be printed to PDF, using the following print options: 
 

• Print product sheet, or generate product sheets for all products 

• Print individual record 
• Print a list of records 

8.1 Print product sheet 

For each product a product sheet can be printed as a PDF, according to a product sheet print 
layout. 
 
A default product sheet print layout is provided with your application, which will print the  
following information: 
 

• Basic product information (brand, series, type, product number, description) 
• Product image and drawing 
• Barcode (EAN or GTIN) 
• Commercial description 

• Product class and product class features information 
 
To print a product sheet: 
 

1. On Product overview, select one or more products 
2. On the Print tab, click on the Product class print button: 
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3. A printable PDF will open in a new browser tab: 

 

8.2 Generate product sheets 

Product sheets can also be generated for multiple products in one go. The function Generate 
product sheet has several options, such as: 
 

• Select different print layouts, optionally in different translations; 

• Automatically add product datasheets as an attachment to your products; 

• Generate product datasheets for all products or a selection of products; 

• Download the product datasheets from an FTPS-location. 
 
To generate product sheets: 
 

1. Through the Menu go to Products > Products: 
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2. Filter and/or Search and then select the products for which you need to generate product 

sheets: 

 
3. On the Function tab click on Generate Product Sheet. In the resulting pop-up window, you 

can choose your options: 

 
a. Layout: Select the print layout for the product sheet. NB: You will be provided with 

a default print layout. For custom layouts, including 
stationary, contact sales@compano.com. 

b. Language: Select the language for the product data6. 
c. Overwrite existing product sheet: Set this option to Yes, if you need to generate a 

new version of the product sheet. This will overwrite the existing version of the 
product sheet which is attached to your product. 

 
6 This option is only available if you have acquired the multi-language module. Contact sales@compano.com 
for more information and pricing. 

mailto:sales@compano.com
mailto:sales@compano.com
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d. Filename product sheet: Type a filename for the product sheet; this will be the 
filename of the downloadable attachment. Certain system variables can be used in 
the filename: 

i. %ProductCode%: Add Product code to filename (mandatory) 
ii. %ItemCode%: Add Item code to filename 

iii. %Language_Code%: Add Langue code to filename, for instance nl or de 
iv. %Language%: Add Language description to filename, for instance 

Nederlands or German 
v. %GTIN%: Add Product GTIN to filename 

vi. %Manufacturer%: Add Manufacturer to filename 
vii. %Fabrikant%: Add Manufacturer to filename 

e. Description product sheet: Type a description for the product sheet; this will be 
the Description of the attachment. 

f. Title product sheet: Type a title for the product sheet; this will be the Title of the 
attachment. 

4. Click on Create and the product sheet will be generated and added as an attachment to 
your product with Attachment Type Link to Sheet (CHR): 

 
5. Click on the link to view the Product Sheet: 

 

 

8.3 Generate item sheets 

Data sheets with Item information are generated in a similar fashion as generating Product sheets: 
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1. Through the Menu go to Items > Items: 

 
2. Select the Item for which you need to generate Item sheets and, under Functions, click on 

Generate Item Sheet: 

 
3. Follow the instructions as per 8.2 Generate product sheets, except for Product substitute 

Item. The following system variables can be used in the filename for the Item sheet: 
i. %ArtikelCode% (mandatory) 

ii. %Leverancier% 
iii. %Supplier% 
iv. %Language_Code% 
v. %Language% 

vi. %Productcode% 
vii. %Itemcode% 

viii. %GTIN% 
ix. %Fabrikant% 
x. %Manufacturer% 

4. A default print layout will be provided. For custom layouts, 
or stationary, contact sales@compano.com. 

8.4 Printing options 

To print information of one record or to print a list of records, use the Printing options print 
button. 

8.4.1 Print list 

To print a list of records: 
 

1. Select the records which you want to print and, under Print, click on Printing options: 

mailto:sales@compano.com
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2. In the pop-up window, select the List option and, optionally, select a printing layout: 

 
3. Click on the Print button. A printable PDF will open in a new browser tab: 

 

8.4.2 Print record 

To print product data of one record: 
 

1. Select the record which you wish to print and, under Print, click on Printing options: 
2. In the pop-up window, select the Product class option and, optionally, select a printing 

layout: 
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3. Next, click on the Print button. A printable PDF will open in a new browser tab: 

 

8.5 Translations 

Product and Item sheets can be printed in different languages, provided that: 
 

• Multi-language license is active 
• Product and/or Item sheet lay-outs for different languages have been prepared 
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Thus, for example, to print a product sheet in the Swedish language: 

• A Swedish product sheet template needs to be prepared 
 
Note: This includes the translations of UDFs on product group and item group. 

8.6 Manage print layouts 

To change the data fields and layout that will be printed, you can add or manage print layouts: 
 

1. On any overview, go to the Print tab and click on Manage [Product class/list layouts] 
2. Choose which kind of layout you want to manage: 

 
3. In the pop-up window: 

a. Name: Type a name for this layout 
c. Application: Choose whether the layout will be available only to you, or to anyone 

within your company 

 
4. On the Properties, Elements and Productoverzicht tab, format the layout. 
5. Save your layout. 

 
Note: Managing a print layout can be quite complicated. Contact Compano Support if you need 
any assistance. Alternatively, Compano can design the layout for you; contact sales@compano.com 
should you wish to make use of this service. 

8.6.1 Show/Hide (ETIM) features 

On the print layout you can now specify which (ETIM) features should be printed on the Product 
Sheet: 

mailto:sales@compano.com
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When creating a product sheet layout, on the Elements tab, you can set the following features to 
be shown (yes) or hidden (no): 
 

• Required features 
• Optional features 

• Unimportant features 
• Undefined features 

8.6.2 Show product number in header/footer 

The product number can be shown in either the header or footer of a product sheet. 

 
This option can be set at the Properties tab of the product sheet layout: 
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8.6.3 Show item data fields on product sheets 

Item fields can be included on printed product sheets; specific item fields can be added on the tabs 
Item and Item details in the Product sheet layout editor: 

 
 

9 Configuration 

The System > Configuration menu can be used to add master data such as conversion tables and 
attachment types, or manage countries and languages, among other things. 

 
Warning: Care must be taken when changing or adding configuration as this can severely disrupt 
your application. If unsure how to proceed, please contact support@compano.com and have 
things explained to you. 

mailto:support@compano.com
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Below follows an overview of the most commonly used configuration settings: 

9.1 Attachment types 

Add all DICO/SALES attachment types (Autofill) and/or create (Add) your own attachment types; 
also see the Manual Attachments and Certificates on the Compano Help-website. 
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9.2 Certificate types 

Add all DICO/SALES, BMEcat, DQR and FAB-DIS certificate types (Autofill) and/or create (Add) your 
own certificate type; also see the Manual Attachments and Certificates on the Compano Help-
website. 

 

9.3 Conversion tables 

Manage Conversion tables, which will allow you to converted values on import or export; also see 
the Manual Universal Import/Export on the Compano Help-website. 

 

9.4 Countries 

Per Country, the following settings can be made: 

https://help.compano.nl/compano-manuals/Manuals-l.html
https://help.compano.nl/compano-manuals/Manuals-l.html
https://help.compano.nl/compano-manuals/Manuals-l.html
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• VAT percentage (hight and low) 

• Currency code 

• Preferred default language 
• Use country-specific fields, for export formats such as DQR, BMEcat or Imperial system 

fields (USA). 

9.5 Custom menu 

In the application, you can create your own (custom) menu, for example to add self-written 
manuals. It is possible to create a menu with multiple sub-levels. 
 

Note: The Custom menu option is only available with a paid license. Please contact 
sales@compano.com should you need this option. 

 
To create your own menu: 
 

1. From the Menu, go to System > Configuration and click on the Menus option: 

 
2. To add a menu, under Edit, click + Add: 

mailto:sales@compano.com
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3. In the pop-up window: 

 
a. Main menu item  (optional): Choose a main menu item here if you are creating a 

menu with multiple sub-levels. Leave this option blank for the top level in the 
menu. 

b. Icon (optional): Upload an icon (image) for the menu. 
c. Order: Type a number for the order in which this menu item is displayed in relation 

to other items. 
d. Description: Type a description for the menu item; this is also the text shown on 

the menu button. 
e. Location: Upload and link a document (e.g. a manual), or type in the URL of a web 

page you want to link to. 
4. Save the record. 

 
The custom menu is visible on a separate tab on each of the overviews: 
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9.6 Languages 

Manage languages available for translations in your application: 

 
Note: Language can be added as a main language or dialect language. 
 
Settings per language are: 
 

• Use multilingual fields 
• Hide in user-interface 

 
For more information, see the Manual Multilingual Data on the Compano Help-website. 

9.7 Fields Fallback 

A Fields Fallback System has been added to the application, as a manual alternative for the 
default Automatic Fallback System. This new system is available for text fields of the entities 
Product, Product group, Item and Item group and allows for manually setting the  to the 
value of any another text data field of the entities Product, Product group, Item and Item group. 
This way, whenever a data field is not filled out, its value will be read from the field it falls back to. 
When required, an en
several consecutive text fields (max. 4). 

https://help.compano.nl/compano-manuals/Manuals-l.html
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9.8 Packing forms 

Add all DICO/SALES packing forms (Autofill) and/or create (Add) your own packaging forms. 

 

9.9 Periodic tasks 

Add or manage Periodic Tasks to automate certain COS-processes, such as Import, 
Export 2BA, Export, Feed export, etc. Also see the Manual Periodic Tasks on the Compano Help-
website. 

https://help.compano.nl/compano-manuals/Manuals-l.html
https://help.compano.nl/compano-manuals/Manuals-l.html
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9.10 Company settings 

Company settings have their own configuration menu, which is available via Menu > My details > 
Compano settings: 

 
Warning: Care must be taken when changing or adding Compano settings as this can severely 
disrupt your application. If unsure how to proceed, please contact support@compano.com and 
have things explained to you. 
 
Company settings allow for various system-wide settings in your application. Which settings can be 
made, depends on your type of application and may include: 
 

• Project administration settings 
• Calculation/Offer settings 

• Purchase settings 

• Financial administration settings 

• Etc. 

mailto:support@compano.com
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9.10.1 Purchasing 

 
• Update when number is adjusted: Set to Yes to ensure that when the number(s) of 

Purchase items is changed, the system will check if a different graduated rate needs to be 
applied. 

9.10.2 Item manager 

 
Download items 
These settings are mostly for Art-Select users. 
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• Send mutation email to: Enter an e-mail address to which the report with price and item 
mutations will be send. If this field is left empty, the report will be sent to the administrator. 

• Automatic export: If set to Yes, an export will be sent to you for each specified export 
frequency and export day. There is a program available for the automatic export of Item 
files AB-Download. The item file is created at night, so that you can retrieve your files 
directly from your mailbox in the morning. 

• Export day: Select the day of the week at which you will receive the data export. 
• Automatically export purchase analysis: Set to Yes if you want the purchase analysis to 

be automatically generated on a weekly basis. 
• Impact report presentation: Specifies whether old value and new values in the impact 

report are presented below each other or next to each other in the report. 
 
Create items 
Settings when manually creating items based on products. 
 

• Transfer product description: Set to Yes to copy the Product Description to the Item 
Description when items are created based on products. 

• Transfer product group: When creating an item based on a product, whether or not to 
copy the product group to article group (yes) or leave it empty (no) 

 
Automatically read data 
 

• Automatic transfer: This is a setting mainly for Artikelbeheer, version 1. If an assortment is 
added locally, it must then be checked and published (Transfer). If there are no errors 
during checking, the assortment will be transferred to the central environment  

• Transfer scheme product: Set the selected ETL transfer schema as the default transfer 
scheme for products. 

• Standard classification system: Set the classification system which is to be used as the 
standard for this application. 

9.10.3 System settings 

 
• Login from the central area: When set to No, logins initiated in the main environment are 

blocked. Note: Setting this to No will prevent any support by Compano or other 
Administrators. 

• Phone number template: Set a phone number template, such as 06 46 11 6993 or (31) 
(0) 646116993. 
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9.10.4 Number pattern 

Set the default number patterns for several automatically numbered entities: 

 
Depending upon your application, the number patterns for the following entities can be set: 
 

• Contacts 
• Support contracts 
• Templates 

• Offers 

• Invoices 

• Recipes 
• Projects 

• Etc. 

9.10.5 International 

 
 

• Country: Default country. The country selected will be used as the default country when 
adding a new relation. 

• Language: Default language. The language selected will be used as the default user-
interface language when adding a new relation and/or user account. 

• Fallback translations: Default at Yes. Set this option to No if you want to make use of the 
Fields Fallback system instead of the default Translation fallback. Also see Manual 
Multilingual Data. 
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• Encoding fallback for import: If the correct character set cannot be determined from an 
import file, fallback to the character set which is specified here: 

 

10 Import data 

Import of data can be handled on the Import / Export tab of an Entity Overview: 

 
Depending to the Entity, several options for importing and exporting of data are available. 
 
Note: Detailed information on importing data is available in the Universal Import/Export Manual, 
which can be download from the Compano Help website. 

10.1 Import scenario’s 

 
 

• Industry standard imports: Used for importing data by means of an industry standard, 
such as DICO (INSBOU/SALES), BMEcat, FAB-DIS, or custom standards, such as Pricat, 
Galvano, etc. 

• Custom imports: Used for importing data from an Excel file or character-separated and 
fixed-width data files, such as CSV or TXT (Unicode) formats. 

• Update imports: Used for updating data. 

10.2 Industry standard import formats 

For easy data exchange a few standard industry formats are available. These data formats can be 
used for importing data into COS: 
 

• PAB (automatic version detection) 
• INSBOU (automatic version detection) 

• SALESBOUWV3 
• DICO/INSBOU (automatic version detection) 

• DICO/SALES (automatic version detection) 

• BMEcat (automatic version detection) 

• OpenData (DQR 6/7); also useful for modern ARGE (DQR 6) import 
• DataNorm; also useful for older ARGE import. 

 
Note: Detailed information on importing data is available in the Universal Import/Export Manual, 
which can be download from the Compano Help website. 

https://help.compano.nl/compano-manuals/manuals-l.html?style=L04
https://help.compano.nl/compano-manuals/manuals-l.html
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10.2.1 Alternative item import formats 

A number of alternative, non-standard item import formats are available, these are: 
 

• Pricat 

• Galvano 
• Sales Construction 
• Plieger 
• VGH 
• eZbase 

 
Note: Detailed information on importing data is available in the Universal Import/Export Manual, 
which can be download from the Compano Help website. 

10.3 Standard import formats (COS PIM-only) 

For PIM-customers several premade standard import formats (Excel) have been added to assist 
with data imports. These formats can be used in combination with accompanying Import layouts 
to import data. These Excel templates are available from the Compano Help website. 
 

Excel template Import layout Used for 

Template New Products and Items 
(DICO/SALES005)7 

Standaard product import in Excel  
L03 

Importing product data 

Template New Products and Items 
(DICO/SALES005) 

Standaard artikel import in Excel  
L03 

Importing item data 

Template Price Updates Standaard prijsupdates in Excel  L03 Importing (new) price information 

Template Import Accessories Standaard import toebehoren 
product  L03 

Importing accessories or parts 
information 

Template Import Accessories Standaard import toebehoren 
product met GTIN  L03 

Importing accessories or parts 
information, using product GTINs 

Template Import Attachments -  Importing attachment information 

10.4 Custom import formats 

Data can also be imported from any type of data file in combination with a proper import layout: 
 

• Excel: The data file is an Excel spreadsheet; 

• Text: The data file is a character-separated text file (CSV or Unicode ). 
 
Note: Compressed versions (ZIP, BZIP2 and 7Z) of Excel-, CSV- or Unicode-files can also be 
imported. Compano recommends using the free, open source software 7zip (https://www.7-
zip.org) to create these files. 
 
Example 
As an example of this kind of import, this paragraph will describe the import of item data. 
However, the import process applies to all types of imports, whether these are on product, item, 
attachments, discount groups, or any other entity. 

 
7 Note: The template for importing new products and items is tailored to the needs of the Dutch datapool 
2BA. 
 

https://help.compano.nl/compano-manuals/manuals-l.html
https://help.compano.nl/compano-manuals/manuals-l.html
https://www.7-zip.org/
https://www.7-zip.org/
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10.4.1 Unicode and UTF-8 encoding 

To import or update data using character-separated text file, your data file needs to be a CSV or 
Unicode file. Both file types use a delimiting character to separate values; CSV uses a semicolon, 
Unicode uses a TAB-character. 
 
For example, opening a CSV file in a text editor will look something like this: 

 
However, beware of saving and/or re-opening in CSV format (!). CSV is notoriously tricky when 
it comes to aracters such as é, à, ê, €, , µ, β ç, et cetera; basically 
anything that is not part of the basic ASCII-127 set. The biggest problem is not CSV itself, but that 
many spreadsheet, ERP- and database programs, including Microsoft Excel, handle CSV-encoding 
unpredictably. 
 
Some common CSV pitfalls are: 
 

• Microsoft Excel (Windows): When using Excel to save as CSV, always use the safe CSV 
UTF-8 (Comma delimited) format. However, older versions of Excel only offer to 

save as CSV (Comma Separated Values) (.csv) . This format 

Windows or Mac codepage which will silently replace any unsupported character in your 
document with an underscore _ character. 

• Microsoft Excel (MacIntosh): This version of Excel cannot save extended characters at all 
and will scramble them into something which is unreadable. 

• Numbers: Apple exports a faulty UTF-8 format which cannot be 
read correctly. 

 
Thus, whenever you need to save your data into a text format for import or export, the best, safe 
option is the Unicode format. This format uses the correct UTF-8 encoding by default. If you 
cannot save your data in the Unicode format, the next best option is to save in the CSV UTF-8 
format. If UTF-
CSV format. It is recommended to check your file by opening it in a text editor (Notepad, 
Notepad++, or other). 
 
Warning: Should you need to alter any data in your spreadsheet, please do so in your original 
Excel-file. Try and avoid editing a CSV-file using MS Excel as this will change large numbers (GLN, 
GTIN) to exponential values 8.713218237987E12 and other problems which makes your data unfit 
for import. 

10.4.2 Custom import layout 

To be able to import a spreadsheet format (either Excel, CSV or TXT), COS needs to know the 
structure of the import file. To identify this structure, an import layout needs to be created that 
will identify how and where data from the import file will be imported into COS data fields. 
 
Example 

http://www.asciitable.com/
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In this Excel file each data line represents one Item. The item data is stored in the following 
columns: 
 

Excel column header Description 

GLN Global Location Number; unique international code for manufacturer 

GTIN Global Trade Item Number; unique international code for an item 

ARTKORT Short description of an item 

ARTNUMMER Item number 

ARTFAK_OM Long description of an item 

ART_PRI_V Gross price of an item 

PRODCODFAB Product code of a manufacturer 

KORTGROEP Discount group 

 
Custom import layouts can be created: 
 
On-the-fly: In the Import dialog, using the +-button: 

 
Or at System > Layouts: 
 

1. Through the Menu, go to System > Layouts: 
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2. Next, under Edit, select Add Import layout: 

 
3. In the pop-up window, select the Entity8 for which you want to define the layout, in this 

example Item: 

 

 
8 An Entity is a data object in COS, for instance Product, Item, Assortment, Attachment, Price, etc. 
 



 

80 
 

4. Click on Add import layout. 
5. In the next pop-up window, fill out the options for the layout on the different tabs: 

 
Layout tab: 

 
a. Type: Choose the Import type: 

i. Excel import: Imports data from Microsoft XSLX-format. 
ii. Text import: Imports data from a Text format, such as CSV or Unicode. 

b. Name: Type a name for the Import layout 
c. Application: Choose whether the layout should be visible for only yourself (For 

me), for all users of this environment (Within the company), or for all 
members/users of all (layered) environments (For all members) 

 
Properties tab: 

 
a. Number of header rows: Set the number header rows contained in your import 

file. Note: These rows will be skipped on import. 
b. Continue on errors: Set to Yes if the import should continue on errors in your data 

file9. Erroneous data will not be imported. 
 

Fields tab: 

 
9 Usually, Continue on errors is set to No, however if you need a report on all the errors in your data file, you 
can set this option to Yes and perform a testrun of your data. 
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a. Available fields: Add data fields to be imported from the list of available fields 
b. Selected fields: Remove unwanted fields from the list of available fields. Note: The 

position number (Pos) indicates from which position (Excel data column) the value 
of the field will be exported. 

c. Properties: Optionally, set options for selected data fields. 
 

5. Click on Save record to save the layout. 
 

Memo tab 
You can use the memo tab to make a note for which purpose this layout was made and how it 
may be used. 

 
Note: Detailed information on importing data is available in the Universal Import/Export Manual, 
which can be download from the Compano Help website. 

10.4.3 Properties for Text import layouts 

Important: Inspect your Unicode/CSV file before you enter the layout features below. You can do 
this by opening the Unicode/CSV file in Notepad or another text editor. A good and free editor is 
Notepad++  https://notepad-plus-plus.org. 
 
On the tab Properties enter the following values where needed: 

https://help.compano.nl/compano-manuals/manuals-l.html
https://notepad-plus-plus.org/
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a. Number of headers: This is the number of rows above the first row with data in your data 

file. Often, there is only one header row which shows the labels of the columns, but there 
may be more header rows. 

b. Format: Choose whether your text file is Character-separated (either semicolon or TAB), or 
if it is a file with a fixed number of characters per line (fixed width). 

c. Separation sign: The default separator sign for a CSV file is a semicolon. Check which 
separator sign is used in your CSV file. Note: If you are using a Unicode file, enter the value 
TAB for the separation character. 

d. Decimal separator sign: Specify the format of the decimal separator sign 
e. Decimal group sign: Specify the format of the decimal group sign 
f. Date separator sign: Specify the format of the date separator sign 
g. Time separator sign: Specify the format of the time separator sign 
h. Text enclosure sign: Sometimes lines of text are enclosed by a text enclosure sign, often a 

quote or double quote. Specify which format your text file uses. 
i. Continue on errors: If set to Yes, the import will continue whenever an error is 

encountered; item with errors will NOT be imported. 

10.5 Optional layout features 

When designing your import layout, you can make use of a couple of optional layout features 
which can facilitate the import process. 
 
Note: Detailed information on importing data is available in the Universal Import/Export Manual, 
which can be download from the Compano Help website. 

10.5.1 Conversion table 

Whenever data in your text file is not in the correct format, you can correct this by making use of a 
conversion table. 
 
In the example above, position 8 (KORTGROEP) contains values such as ’01, ’02, etc. As the 
quote in front of the numbers is not correct, you can create a conversion table where the values are 
replaced: 
 
 

https://help.compano.nl/compano-manuals/manuals-l.html
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Value IN Value OUT 

 01 

 02 

Etc.  

10.5.2 Fixed values 

For some fields in your layout, fixed values can be used. Two scenarios with fixed values are: 
 

• For all data records, the value is the same, fixed value. For instance, Price Unit 
• Wherever the value for the data field is empty in the import file, a fixed value should be 

written into COS. For instance, price data: 
 
Note: Detailed information on importing data is available in the Universal Import/Export Manual, 
which can be download from the Compano Help website. 

10.5.3 Maintain data (no overwrite) 

To prevent overwriting of data in COS on import, set the Maintain option of a data field to Yes: 

 

10.6 Importing data files 

To import any type of data file: 
 

1. Go to the Import/Export tab of any Entity and click on Import: 

https://help.compano.nl/compano-manuals/manuals-l.html
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2. In the pop-up window, select your data file10, and click on Next: 

 
3. In the next dialog window, you will be presented with one or more data Layouts11. If your 

import file contains multiple data files or Excel worksheets, these are automatically 
detected and named Layout1, Layout2, etc.: 

 
For each Layout: 

a. Import entity: Select an Import entity.  
b. Import layout: Select an Import layout, or alternatively , add a create an import 

layout using the +-buttons. Note: Optionally skip importing of a data Layout by 

not selecting an Import entity and/or Import lay-out. 
4. Click on Next for the Import settings: 

 
10 Note: Excel files with multiple worksheets or compressed files (ZIP, BZIP) containing multiple data files can 
also be imported. For importing multiple data sources, multiple import layouts need to be selected. 
11 Note: Industry standard files will be auto-detected; no Import layout is necessary. 
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c. Reporting level: Select the reporting level for the import report: 

i. None: Do not generate an import report. This will result in the fastest 
import. 

ii. Full: Generate a full import report, including all changes in all fields. This 
will result in the slowest import as all fields will be checked. 

iii. Only warnings: Generate an import report only listing warnings. This 
import is generally faster than with a Full report. 

d. Is testrun: Set to Yes to simulate an import; this will only generate an import report 
listing any potential error and/or warnings. No data is actually imported! 

e. Selected files: (De-)select the files from your multiple data set which you need to 
import. 

5. Click on Next to start the import. You will receive an e-mail with an Import report. 

10.6.1 Multiple data sources 

The Universal import method also provides for importing multiple data source at once. The 
following data files can contain multiple data sources: 
 

• Multiple worksheets (Excel): An Excel file with multiple data worksheets 
• Compressed data file (ZIP, BZIP): Compressed format containing multiple data files 

 
Important: Each data source needs to be linked to an Entity and imported with a separate import 
layout. 
 
On import, an Entity and Layout need to be assigned to each data source, as demonstrated below: 
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For more information on Importing multiple data source, see the Manual Universal Import/Export 
available from the Compano Help website. 

10.7 Import 2BA 

Depending upon the setup of your version of the Compano software, a direct import of 
assortments from data pool 2BA is an option: 
 
To import an assortment directly from the 2BA data pool: 
 

1. Through the Menu, go to Items> Assortment. 

 
2. On the Import/Export tab, click on Import 2BA: 

https://help.compano.nl/compano-manuals/manuals-l.html
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a. Supplier: Automatically selected. 
b. Item format: Select to file format for import 
c. Products (product data + class): Set to Yes to import product (classification) data 
d. Add new manufacturer: Add a new manufacturer if not already present in COS 
e. Changes since: Only import changes in the data since [selected date] 
f. Testrun only: Set to Yes to simulate a 2BA import; an import analysis will be made 

available 
g. Authorize URL: Set automatically. 
h. API URL: Set automatically 
i. UserName: Enter your 2BA account username 
j. Password: Enter your 2BA account password 
k. ClientID: Enter your 2BA account client ID 
l. Secret: Enter your 2BA account secret code 
m. Enrich profile: Set to Yes to enrich product information based on product GTIN. 

Note: When set to No, incomplete products from 2BA will not be downloaded. 

10.8 Automated imports 

Imports of (industry standard) data can be automated using either Periodic Tasks, FTPS or a 
combination of both. 

10.8.1 Industry standard data 

For automated imports of Industry Standard data (PAB, DICO/INSBOU, DICO/SALES and BMEcat) 
please see Appendix A: FTPS access: paragraph 13.8 INDUSTRY STANDARD DATA 

(AUTOIMPORT/AUTOCHECK). 

10.8.2 Periodic import task 

Any other type of data can be imported using Periodic Tasks. More information can be found in the 
Manual Periodic Tasks, which is available from the Compano Help website. 

https://help.compano.nl/compano-manuals/manuals-l.html
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11 Export data 

Item and product data in COS can be exported, using: 
 

• Industry exchange standard 
• COS screen layout 
• COS export layout 

 
Note: The example in this chapter concerns export of item data. However, the export process 
applies to all kinds of exports, whether these are on product, item, attachments, discount groups, 
or any other entity. 
 
Note: Detailed information on exporting data is available in the Universal Import/Export Manual, 
which can be download from the Compano Help website. 

11.1 Standard export formats 

Should you choose to export data using one of the industry exchange formats, you have the option 
to either export all items of an assortment, or export (a selection of) items directly. 
 
Warning: Please pay close attention to your settings when switching between export formats! 
Settings in the export dialog below are stored per user, however common settings are retained 
when selecting a different export format. Thus, for instance, when exporting in the FAB-DIS format 
with the ETIM 8 setting, this setting is retained when switching back to the DQR export format.  

11.1.1 Export Assortment 

To export all items of an assortment: 
 

1. Through the main menu go to Items > Assortment. 
2. Go to Import / Export tab, select an assortment and click on Item exports: 

 
3. In the pop-up window: 

https://help.compano.nl/compano-manuals/manuals-l.html
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a. Send export to: Enter an email address; the export will be sent to this address 
b. Software package: Should wish to export in a specific software format, select a 

package. If not, select Other: 

 
c. Free text export: Set to Yes, to select a Text export format. Set to No, to export in 

an industry standard format. 
d. Item Format: Select an industry standard format for the export: 
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Note: Depending on the industry format which was selected, the following export 
options differ. For unique options the corresponding standard is shown in 
parenthesis. 

 
i. Country: Choose to only export items with this [country] of origin 

ii. Language: Select in which language data should be exported 
iii. Guideline: (BMEcat / ARGE12) Select the BMEcat or ARGE12 Guideline 

version 
iv. LUCID number (OpenDataCheck): Enter the LUCID number (optional) 
v. Disposal service provider (OpenDataCheck): Enter the name of the 

disposal service provider 
vi. WEEE items (OpenDataCheck): Yes/No, select whether assortment 

contains WEEE items 
vii. Modelnumber (OpenDataCheck): Select which entity functions as the 

model number 
viii. Item group (OpenDataCheck): ): Select which entity functions as the item 

group 
ix. Product group (OpenDataCheck): ): Select which entity functions as the 

product group 
x. HTML text: (BMEcat) 

xi. Catalog version: (BMEcat) 
xii. Add images + attachments: (ARGE11/12), export a zip-file including 

images and other attachments 
xiii. Price Book No.: (IGH) 
xiv. Release no. (IGH) 
xv. Version year: (IGH) 

xvi. Customer organization: (BMEcat / IGH) 
xvii. Organization ID: (IGH) 

xviii. Prices: Select which prices should be exported 
xix. Future prices: Yes/No; choose whether to export prices with a future price 

date 
xx. Including archived items: Yes/No; choose whether to include cancelled 

items 
xxi. Products: Yes/No; choose whether to export Product class 

xxii. Features: Yes/No; choose whether to export Product class features 
xxiii. AttachmentIndex: Yes/No; exports fixed length text file containing 

product/item number and corresponding attachment(s); automatically 
included for INSBOU004 and SALES005. 

xxiv. Classification system: Choose which classification should be used when 
exporting the classification data 

xxv. Item relations (koppelingen.txt / ItemRelations.xml): Yes/No; choose 
whether to export all item relations (parts, accessories, alternatives) to 
internal/external URLs 

xxvi. Changes since: Only export items which have been changed since [date] 
xxvii. Price Reference date: Only export prices from this [date] 

xxviii. Start Date: (ARGE 11/12, BMECat) 
xxix. End Date: (ARGE 11/12, BMECat) 
xxx. Add Bonus Group based on discountgroup: (ARGE 11/12) Yes/No; 

choose whether to export the bonus group 
 
Note BMECat export: When exporting item data of an assortment in BMECat format, any 
attachments are exported to your FTPS-folder, provided the option Add images + attachments has 
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. You will be notified via e-mail of the FTPS-location, where you can download the 
attachments as a ZIP-file. As this option differs from the usual download protocol, no log entry will 
be made. 
 
Note: Detailed information on importing data is available in the Universal Import/Export Manual, 
which can be download from the Compano Help website. 

11.1.2 Export Items 

Alternatively, you can first select a subset of items, using the Filter and Search options: 
 

1. Through the main menu, either go to Items > Items, or Items > Assortment > Items 
2. Using the Quickfilter, the Filter and/or Search, make a selection of items 
3. On the View tab, click on the All/Deselect toggle button, to select all items in your selection 

(or, CTRL-A): 

 
4. Go to the Import/Export tab and click on the Item exports button: 

 
5. In the pop-up window: 

https://help.compano.nl/compano-manuals/manuals-l.html
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a. Send export to: enter an email address; the export will be sent to this address 
b. Software package: should wish to export in a software-specific format, select a 

package. If not, select Other: 

 
c. Free text export: No 
d. Item Format: Choose according to which format the data should be exported: 

 
Note: The following export options differ depending on the standard format which was chosen. For 
unique options the corresponding standard is shown in parenthesis. 
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a. Prices: select which prices should be exported 
b. Including cancelled features: (BMECat) 
c. Products: Yes/No; choose whether to export Product class 
d. Features: Yes/No; choose whether to export Product class features 
e. AttachmentIndex: Yes/No; export fixed length text file containing product/item 

number and corresponding attachment(s); automatically included for INSBOU004 
and SALES005 export formats. 

f. To classification system: choose which classification should be used when 
exporting the classification data 

g. Changes since: Only export data for items that have been changed since this 
[date] 

h. Links: Yes/No; export all links to internal/external URLs 
i. Manufacturersinfo in export: Yes/No; choose whether to export manufacturer 

info 
j. Price Reference date: Only export prices (price records) up until and including this 

[date] 
k. Start Date: (ARGE 11/12, BMECat) 
l. End Date: (ARGE 11/12, BMECat) 
m. Country: Country of origin 
n. Language: select in which language data should be exported 
o. Guideline: (BMEcat) 
p. HTML text: (BMEcat) 
q. Catalog version: (BMEcat) 
r. Customer organization: (BMEcat) 
s. Add images + attachments: (ARGE11/12), export a zip-file including images and 

other attachments 
 
Note: Detailed information on exporting data is available in the Universal Import/Export Manual, 
which can be download from the Compano Help website. 

11.1.3 Country-specific fields 

On products and items, country-specific fields for exports and certain industry formats (for 
example, for BMEcat 2005) can be enabled, such as UBA Positiv Liste (Germany) or LIV-number 
(Finland). 
 
Country-specific fields can be enabled or disabled per country via the Country table in the 
Configuration overview. This applies to country-specific ETIM attributes as well as other country-
specific fields, such as LVI number, SEG number, UBA positive liste etc: 

https://help.compano.nl/compano-manuals/manuals-l.html
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Note: Detailed information on country-specific fields is available in the Universal Import/Export 
Manual, which can be download from the Compano Help website. 
 
Country-specific fields of Product in Item field selector 
All country-specific fields of Product can now be selected in the field selectors of Item (screen 
layout, export layout). 
 
Note: These fields will not appear on the pop-up screens of Detail, Edit and Filter. 
 
Important: Available Product country-specific fields are listed in the field selector under the 
category Item > Country-specific fields, with the prefix Product. 
 

11.1.4 Metric/imperial system fields 

The conversion of Imperiale to Metric measures and vice versa is done via user-defined fields and 
their mapping to ETIM attributes. See also the Manual Metric/Imperial. 
 
However, the Height, Length, Width, Weight, Volume system fields and their units, such  
as Meter, Kilo and Cubic Meter, are listed as USA country-specific fields and  are available 
when enabled at the USA country. When a system field is filled in, its Metric or Imperial counterpart 
is calculated and filled in. 
 
Note: Calculation of Metric or Imperial values is automatic as soon as one of the two fields is filled 
in. By removing the checkmark next to 'automatic', the automatic value can be overwritten with a 
self-filled value. This can be useful, for example, for nominal values, where a calculated value of  
50.8 is equal to the nominal connection size 50. 
 
Note: The metric value is leading in the conversion. However, the Imperial value for each 
product/item can be manually 'overruled' by removing the checkmark from 'Automatic'. 

https://help.compano.nl/compano-manuals/manuals-l.html
https://help.compano.nl/compano-manuals/Manuals-l.html
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11.1.5 Imperial conversion for UDF type Table value 

For user-defined fields of type Table value, a Imperial value can now also be filled in (extra field). 
This value is converted from the Metric value and cannot be adjusted. Associated ETIM attributes 
are provided with an additional field for an Imperial value; This too cannot be changed. 

11.2 Custom export format 

Should you wish to export data from COS using your own custom data layout, you have two 
options: 
 

• Export with screen layout 

• Export with custom layout 

11.2.1 Export with screen layout 

Any records in COS can be exported using the Overview of an entity: 
 

1. Navigate to the Entity where you want to export data records. 
2. On the View tab, select one of the existing screen layouts (or make a new one): 

 
3. Go to the Import/Export tab and click on the Export button: 
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4. In the pop-up window, set the option Use screen layout to Yes. Note: Leave the 

Prepare for Import option set to No: 

 
5. Next, click on the Export button. This will generate an Excel file containing your data. 

 
Note: Detailed information on importing data is available in the Universal Import/Export Manual, 
which can be download from the Compano Help website. 

11.2.2 Export with custom layout 

Alternatively, you can design your own export layout. 
 
To export with your own screen layout: 
 

1. Navigate to the overview of data you want to export 
2. Go to the Import/Export tab and click on the Export button: 

 
3. In the pop-up window: 

https://help.compano.nl/compano-manuals/manuals-l.html
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a. Use screen layout: Set to No. 
b. Export layout: Either select a premade Export layout, or create a new one 

using the +-button; The process for designing the layout is similar to 10.4.2 

Custom import layout. 
c. Prepare for import: Set the option Use screen layout to No. 

4. Next, click on the Export button to start the export. This will generate an Excel file 
containing your data. 

 
Note: Detailed information on importing data is available in the Universal Import/Export Manual, 
which can be download from the Compano Help website. 

11.2.3 Export for updating data 

Data in COS can be updated using a combination of Export and Import. The data is exported as a 
special ExcelForImport file. Data in this file can be edited and then imported back into COS. 
 
Any Excel export layout can be used to create an ExcelForImport-file, by setting the Prepare for 
import option to Yes: 

 
The resulting Excel file will be named COS-ExcelForImport-[ENTITY]-[DATE]-[TIME].xlsx 

Important: When renaming an ExcelForImport file, always make sure the filename starts 
with COS-ExcelForImport, otherwise the update import will not work properly. 

To update data, edit this ExcelForImport-file with Microsoft Excel. Subsequently, use the Import 
function in COS to import the updated data. 
 

https://help.compano.nl/compano-manuals/manuals-l.html


 

98 
 

Important: Worksheets in an ExcelForImport file are protected; should you remove this protection, 
then Compano cannot guarantee that any changes in the file will be imported correctly. 
 
 
Note: Detailed information on importing data is available in the Universal Import/Export Manual, 
which can be download from the Compano Help website. 

11.3 HTML-formatted data 

Certain data fields in COS can contain HTML formatting code, for instance the Commercial 
Description field. When exporting these data fields, please note: 
 

• Custom export: The HTML-code is stripped on export; the export file will contain no HTML-
codes. 

• Export for import: The HTML-code is exported; the ExportForImport-file will contain 
HTML-codes, which can be updated and imported back into COS. 

11.4 Automated exports 

Data can be automatically exported using Periodic Tasks. More information can be found in the 
Manual Periodic Tasks, which is available from the Compano Help website. 

12 Manually entering data 

Importing data is usually the preferred method for data entry, however manually adding data is 
also an option. This chapter describes how to add product data, generate an item based on a 
product and complement the item data. Adding product and item data is also discussed. 

12.1 Add manufacturer 

To add a (new) manufacturer: 
 

1. Through the Menu, go to Products > Manufacturers: 

 
2. Under Edit, click on +Add to add a new manufacturer: 

https://help.compano.nl/compano-manuals/manuals-l.html
https://help.compano.nl/compano-manuals/manuals-l.html
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3. In the pop-up window: 

 

 
Manufacturer tab 

a. Code (GLN): Enter the Global Location Number of the manufacturer 
b. Manufacturer: Enter a name/description of the manufacturer 
c. Logo (optional): Upload a logo of the manufacturer 
d. Manufacturer type: Select the manufacturer type: 

i. Manufacturer: Default option. 
ii. Standard manufacturer: Used with standardised products (standardisation 

system). 
iii. Unknown: No longer used (Artikelbeheer.nl) 

e. Data manager (optional): Select a relation who is responsible for data 
management of product data. 

f. Product number template (optional): Products can now be copied while 
retaining all product data, including classification. A product number for the new 
product will be generated, based on the product number template. For instance, 
00000-00 denotes a number template of 5 digits, a dash and 2 more digits. 

 
Note: The #-character can be used as a wildcard in the template. For instance, if you 
have two product number variants, NA-0000 and RX-0000, then the product 
number template should be ##-0000; thus products with both number variants can 
be copied. 
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Organization tab (optional) 

 
a. Organization: Optionally, select an Organization from the available relations. 

 
Item manager 

 
a. Central manufacturer (optional): Select a central manufacturer. 
b. Deeplink template: Refer to a template for the deeplink to products, for instance: 

https://products.my-compano.com/f.asp?f=foto-%code%.jpg 
c. Product image URL: Set a template for the product image 
d. Product drawing URL: Set a template for the product drawing 
e. DataOwner: Select the data owner for data pool Artikelbeheer.nl; the product data 

of this manufacturer can only be edited and transferred to Artikelbeheer.nl by this 
data owner. 

4. Save by clicking on Save record. 
 

URL wildcards 
 to generate the correct URL for deeplinks, images or 

drawings: 
 

• %code%: the product code 
• %prdGTIN%: GTIN of the product 
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• % prdgroup%: product group code 
• %erpcode%: ERP code 

 
5. Save by clicking on Save record. 

12.2 Add individual product 

To add a product: 
 

1. Through the main menu, go to Products > Products 

 
 

2. Under Edit click on +Add: 

 
3. In the pop-up window: 

 
Product tab 
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a. Manufacturer: Select a manufacturer 
b. Code: Enter the product code 
c. Short description: Enter a short description for the product (max. 70 

characters) 
d. Product description: A longer description for the product (max. 256 

characters). Note: Short and long description need to be different to be 
accepted by 2BA and InstallData data pools. 

e. GTIN: Enter the unique international product identifier. 
f. Company-specific product code (optional): Enter a code for internal product 

reference which is different from the Product code. 
g. ERP code (optional): Enter a code by which the product is identified in the 

manufacturers ERP system. 
h. Country of origin: Select the country where the product was produced. 
i. Publication: Select the publications in which the product should appear, for 

instance, your webshop. 
j. UNSPS: Enter the United Nations Standard Products and Services Code. The 

UNSPS code is a hierarchical coding system to classify both products and 
services for use in eCommerce. It is a hierarchy with four levels that is coded as 
an eight-digit number. 

k. Group Code: Enter the product Group code. 
l. Brand: Enter the Brand name. 
m. Series: Enter the product Series. 
n. Type: Enter the product Type. 

 
Other tab 
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Additional product information can be filled out on the Other tab, including: 

a. Available: Set the Availability status of the product. 
b. Predecessor / Successor: Enter the product/GTIN codes for the predecessor 

and/or successor products. 
c. ADR: Enter product safety information. 
d. Size: Enter product size and weight information. 
e. Data: Set dates for introduction and/or end-of-life of the product. 

4. Optionally add additional product information on the other tabs, such as Commercial 
description, Technical description, User defined fields, Translations. 

5. Save the product. 

12.3 Add supplier 

To enter a (new) supplier: 
 

1. Through the Menu, go to Items > Suppliers: 
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2. Under Edit, click on +Add. 
3. In the pop-up window: 
 
Supplier tab 

 
a. Organization (optional): Optionally select an Organization. Note: Organization 

information can be entered through the Menu > Contacts > Organizations. 
b. Code: Enter a letter code for the supplier. Note: The letter code must consist of at 

least 4 letters, for instance VHMIJ. 
c. Description (optional): Enter a description for the supplier. 
d. Supplier: Enter a short description for the supplier. Recommended is to use the full 

supplier name. If this is a long name, it is advisable to enter a shortened version. 
e. Logo (optional): Upload a logo for of the supplier. 
f. GLN code: Enter the Global Location Number of the supplier. Note: If the data of 

can be used. More information is available from your Compano consultant 
g. Manufacturer: Select the manufacturer to which items of this supplier are to 

linked. 



 

105 
 

 
Links tab 

 
 

h. Deeplink template: Refer to a template for the deeplink to items. 
i. Image deeplink items12: Set an URL-template for the item image 
j. Drawing deeplink items: Set an URL-template for the item drawing 
k. Access to supplier website: If you have an account which lets you access a suppliers 

website for download of information, you can use the following fields: 
i. Customer number: Your customer number at supplier. 

ii. User name: Your username, as you use it on the supplier's website. 
iii. Password: Your username, as you use it on the supplier's website. 

4. Click on Save record to save the supplier. 

12.4 Add assortment 

To add an assortment for the supplier: 
 

1. Through the Menu, go to Items > Suppliers: 

 
12 Note: URL a deep links can be built up to an image or drawing. For example 

http://catalogus.fabrikant.nl/f.asp?f=foto.jpg&art=%prdcode% 
 

 

• % prdcode%: the product code 

• %prdGTIN%: GTIN of the product 

• % prdgroup%: product group code 

 

http://catalogus.fabrikant.nl/f.asp?f=foto.jpg&art=%25prdcode%25
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2. In the overview, select the supplier and, under Navigation, click on Assortments: 

 
3. On the next screen, under Edit, click +Add to add a new assortment for this supplier: 

 

 
4. In the pop-up window: 
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a. Supplier: This field is automatically set to the supplier you selected. 
b. Type: Set the type of assortment to either Purchasing (default) or Sales. 
c. Item type: Set the type of item in the assortment to Buy (default), Rentals or 

Service. 
d. Code: Set a letter code for the assortment. Note: Usually this is the same code 

as set for the Supplier. 
e. Description (optional): Enter a description for the assortment. 
f. Logo (optional): Upload a (supplier) logo for the assortment. 
g. Data manager (optional): Set a data manager for the assortment. Note: only 

the data manager can add or edit the assortment. 
5. Save the assortment by clicking on Save record. 

12.5 Add individual items linked to products 

Items linked to a corresponding product can be added to the assortment: 
 

1. Through the main menu, go to Items > Assortment: 
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2. Under Navigation, click on Items: 

 
3. Next, under Edit click on the Item < Product button. This way an item will be created, linked 

to a product already in the system: 

 
4. On the next screen, select one or more products: 

a. (Quick)Filter and/or search one or more products (1) 
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b. Select the product(s) by clicking in the overview (2) and click on Select Product. The 
selected product(s) will be moved to the Shopping cart13. 

c. Next, click on Transfer (4) to generate the item(s) based on this product(s). 

 
Once the item(s) has been created you can fill out more detailed Item information: 
 

1. Through the main menu, go to Items > Items 
2. On the View tab, use Filter and/or Search to find the Item you just created: 

 
3. Go to the Edit tab and click on Modify to change/add any Item information: 

 

 
13 Note: The shopping cart is limited to 1000 records. 
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a. Supplier: Select the supplier of the item. 
b. Item number: The item number is an item identification code. Within an 

assortment, the item number must be unique. 
c. Short description: Enter a description for the item (max. 70 characters). 
d. Product description: Enter a description for the item (max. 256 characters). 
e. Description 1: Only used with the Arge Neue Medien export format (max. 40 

characters) 
f. Description 2: Only used with the Arge Neue Medien export format (max. 40 

characters) 
g. GTIN: Enter the Global Trade Item Number for the item. 
h. Own item number: Optional code for internal item reference which is different 

from the Item Number. 
i. Assortment: Select the assortment to which the item should be added. 
j. Condition group code: Enter the code identifying the condition group for this 

item. 
k. Group code: Enter the Item Group code. Note: an assortment can be ordered 

hierarchically based on the MGSI structure. (Main Group, Group, Sub-Group, Item). 
l. Calculation unit: Select the unit which is used for calculation of item cost. 
m. Order unit: Select the unit which is used to order the item. 
n. Number of CU per OU: The number of Calculation Units which make up an Order 

Unit. 
o. Number of PU per OU: The number of Price Units per Order Unit is a conversion 

factor which indicates the ratio between the price unit and the order unit, with the 
purpose of calculating the price per order unit. This is required if it is an orderable 
item (Code Orderability = TU). It is advisable to reserve 3 decimal places for this 
attribute. 

p. Minimum purchase in Order Units: The minimum purchase in Order Units 
indicates the minimum number of units that must be ordered. For example, the 
minimum purchase in order units for LED bulbs is 10 pieces (i.e. 1 box). 

q. Order increment: Order increment is the step size of the order, based on the 
minimum purchase. For example, based on the minimum order of 10 pieces (i.e. 1 
box) and an order increment of 5, boxes of 10 LED bulbs can be ordered in the 
quantities 5, 10, 15, 20, 25 etc. 

12.6 Add surcharge 

Surcharges can be entered which will be added to the net price of an item: 
 

1. Through the Menu, go to Items > Items. 
2. Select an Item and, under Navigation, click on Surcharges: 
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3. On the next screen, under Edit, click on +Add: 

 
4. On the pop-up screen: 
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a. Item: Is automatically filled-out. 
b. Type: Select a type of surcharge, for example: AEO – Disposal fee. 
c. Description: Type a description for the surcharge. 
d. Sequence*: Set the sequence in which this surcharge appears on the overview. 
e. Start date*: Set a start date for the surcharge. 
f. End date*: Set an end date for the surcharge. 
g. Lower limit*: Set a lower limit for the surcharge. 
h. Amount per price unit (PU) and price quantity (PQ) *: Set the surcharge amount 

per PU and PQ. 
i. Amount per order unit (OU) *: Set the surcharge amount per OU. 
j. Amount per calculation unit (CU) *: Set the surcharge amount per CU. 
k. Percentage*: Set the surcharge as a percentage of the gross price. 

 
*) Optional fields 

12.7 Copying products/items 

Products and items can be copied using either the CTRL-C, CTRL-V hotkeys, or the Copy and Paste 
option from the Edit menu: 

 
Note: When copying Products and Items, the GTIN data field will be left empty in the copy as no 
two products or items can have the same GTIN. 

12.7.1 Copying products 

To be able to copy products, the Product Number Template has to be set at the Manufacturer; see 
also 12.1 Add manufacturer. 

12.7.2 Copying items 

Should your Items be linked to items in a Purchase assortment, this link will not be copied to a copy 
of that item; i.e. the copy will not be linked to the same Purchase Item. 

12.8 Adding product / item groups 

Product and item groups are managed through the Configuration menu: 
 

1. Through the main menu, go to System > Configuration: 
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2. In the next window, click on either Item Groups or Product Groups: 

 
3. Continuing this example with Product Groups, click on Add, to add a new product group: 

 
Product groups have an hierarchical structure. First, add all level 1 groups, next select one of the 
level 1 groups and add the level 2 groups. For instance, the level 1 group LAMPS has 7 underlying 

level 2 groups: 
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To add lower level groups: 

1. Select (1) the group to which you want to add lower level groups 
2. Under Navigation, click on Productgroups (2) 
3. On the next screen, add any level 2 product groups using Add (3): 

 
4. Each level 2 group can, in turn, have further lower-  

12.8.1 Assigning product / item groups 

To assign products to a product group, simply add the group code to the product: 
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12.8.2 Copying product / item groups 

Product and/or Item groups can be copied from one manufacturer to another, or from assortment 
to another. 
 
Note: The copy-actions need to be performed on the Manufacturer > Product groups overview, or 
the Assortment > Item groups overview 

13 Appendix A: FTPS access 

Implementation of an FTPS account for (new) Compano customers consists of: 
 

• Adding one or more FTPS-user accounts (by Consultant) 

• Automated generation of account folders and settings (by FileZilla FTPS server) 
• Optional: FTP account management (Compano customer) 

 
Three types of FTPS-accounts can be added: 
 

• Standard FTPS user: Used for downloading (large) analyses and other (data)files 
generated by the application. A free FTPS user account is included with most Compano 
applications. Standard FTPS users have access to the folders: 

o Download 
o Attachments 

• Upload FTPS user: Used for uploading data; i.e. (automated) import. This extra FTPS user is 
only available as an extra paid service. Please contact sales@compano.com for options and 
pricing. Upload FTPS users have access to the folder: 

o Uploads (and any subfolders) 
• Download FTPS user: Used for downloading data from a specified (set of) folder(s). This 

extra FTPS user is only available as an extra paid service. Please contact 
sales@compano.com for options and pricing. Upload FTPS users have access to the folder: 

o Downloads (and any subfolders) 

13.1 Add FTPS user 

The first FTPS account for Compano customers is free of charge. This concerns a standard FTP 
account with access to FTPS folders Downloads and Attachment. Any extra, paid-for, FTPS-
accounts can be used to automate data imports, or give access to upload or download information 
to specified folder(s). 
 
Please contact sales@compano.com for more information on options and pricing. 
 
Note: It is recommended to have FTPS accounts added by a Compano consultant. 

13.2 FTPS-folder access 

Access to FTPS-folders depends upon the type of FTPS-user. 

13.2.1 Standard FTPS-user 

A standard FTPS-user will have access to the folders: 

mailto:sales@compano.com
mailto:sales@compano.com
mailto:sales@compano.com
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• Attachment: Used for uploading attachments for products, items, product groups, item 

groups, feeds, etc. 

• Downloads: Used for downloading large data files or reports; some application functions 
can generate large, usually compressed, data files. These files can be downloaded from this 
location. 

13.2.2 Extra FTPS-user 

For extra FTPS-user accounts access to additional folder(s) can be set, such as: 
 
• Uploads: Used for (automated) data file uploads. When uploaded files are to be used for 

imports, it is recommended to add an additional Import subfolder under Uploads. 
• Downloads: To allow only download access to the Downloads folder or any subfolders 

thereof. 
 
For automated imports, two additional subfolders can be added: 
 
• AutoCheck: An Industry Standard data file (PAB, INSBOU, SALES or BMEcat) placed in this 

folder will be compared within the hour with the current dataset, based on Global Location 

Number (GLN)14. A report will be send to the e-mail address indicated in the parameters.xml 

of the data file. Note: The file must always be manually placed in the AutoImport folder for 

actual processing, unless the following is indicated in the parameters.xml of the data file: 

<PublishMethod>AutoAcceptStagingData</PublishMethod> 

• AutoImport: Any data file placed in this folder will be imported and processed within the 

hour. For Industry Standard data files, a report is sent to the e-mail address indicated in the 

parameters.xml of the data file. For other data files, a report is available through the Log 

files. 

 
14 When offering an Industry standard file (PAB, INSBOU, DICO/SALES, BMEcat) and a new GLN is detected in the dataset, 
a new Assortment, Manufacturer and Supplier will be created. 
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Note: Failed, Processed and NotRecognized folders will be generated automatically after a 
failed/successful import. 

13.3 Add FTPS folders 

Additional folders need to be added by the Compano consultant. Note: This includes the Uploads 
(root) folder! 
 
To add a folder: 
 

1. When adding the FTPS user, in the Add new user window, next to Rootmapftp, click on the 

 -button: 

 
2. In the next pop-up window, click on the folder + icon: 

 
3. Enter a folder name, for instance Uploads: 
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4. Click on OK to add the new folder. 

 
Note: The file explorer is similar to Microsoft Explorer and can be used to add folders and different 
levels. 

13.4 Security settings 

13.4.1 IP address 

To further prevent unwanted access, logon attempts can be limited to a (set of) IP addresses: 

 
Notes: 

• Setting Allowed IP Addresses is mandatory15. 

• Multiple allowed IP addresses should be separated by semicolons; 

 
15 IP-addresses are mandatory as of April 1st, 2023. 



 

119 
 

• IP ranges such as 88.15.12.20/24 are allowed. 

When in doubt, ask your system administrator or IT department about the 
correct IP Address for your organization. 

When working from home, make sure to add your public IP address. This can be 
https://whatismyip.com/  

13.4.2 FTPS security and firewall settings 

The FTPS protocol uses encrypted data transfer for which the following settings are mandatory: 
 

• Encryption: Use explicit FTP over TLS on port 21 
• Data transfer: Ports 64441 through 64447 

Inform your system administrator or IT department about the correct settings 
for ports in the firewall . 

For questions, please contact Compano Support, +31882667202 or 
support@compano.com.  

13.4.3 Read only 

By setting the Read only option to Yes, the FTPS-user can only make use of FTPS to download any 
data. Also, this user 
delete any files on the FTPS server. 

13.5 FTPS folder recycling (clean-up) 

-up. The recycle schedule 
is as follows: 
 

FTP folder Production application Prerelease application 

Downloads / Uploads Every 6 months Every 6 months 

Temp Every 13 months Every 4 months 

 
For files larger than 1 Gb, a shorter period is used when cleaning old files in the Downloads 
directory. In a Production environment they are removed after 2 weeks and in a PreRelease/Test 
environment after 1 week. In addition, the Uploads directory is now included in the cleanup. It uses 
the same periods as with Downloads. 

13.6 Periodic tasks 

Periodic tasks, such as Import products, also depend upon FTPS. This way, automated imports can 
be set. For a detailed explanation of the automated import, please see contact your Compano 
consultant or support@compano.com.  

13.7 FTPS URLs per application type 

 

https://whatismyip.com/
mailto:+31882667202
mailto:support@compano.com
mailto:support@compano.com
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Application type FTP URL 

Production Ftps.compano.com 

PreRelease FtpsPreRelease.compano.com 

Test FtpsTest.compano.com 

13.7.1 FTPS port settings (firewall) 

FTPS communication uses a custom port range. The following port range on a firewall should be 
set to allow traffic: 
 

Port range: 64441 - 64447 

13.8 Industry standard data (AutoImport/AutoCheck) 

FTPS can be used in combination with the FTPS folders AutoImport and/or AutoCheck to 
automate the import of industry standard data files PAB, DICO/INSBOU, DICO/SALES or BMEcat. 
 
Note: This combination makes use of an extra FTPS user account for uploads and needs to be setup 
by a Compano consultant. Please contact sales@compano.com for options and pricing. 

13.8.1 Submit data to Artikelbeheer.nl 

For use of FTPS to submit data to Artikelbeheer.nl, please see the manual Aanleveren aan 
Artikelbeheer.nl (Dutch only) which is available from the Compano Help website. 

13.8.2 Submit data to own assortment 

Important: The FTPS protocol uses encrypted data transfer. For added security, the upload of data 
is only allowed from certain IP addresses. 
 
Delivery via FTPS: 
 

• The data must be offered in one of the following industry formats: PAB, INSBOU, 
DICO/SALES or BMEcat). 

• On the FTPS server there are 2 folders ready: 

mailto:sales@compano.com
https://help.compano.nl/compano-manuals/manuals-l.html
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o AutoCheck: Data file is compared with current dataset on Artikelbeheer.nl; a report 

is drawn up and sent. Note: After approval, the file must ALWAYS be manually 

placed in the AutoImport folder for actual processing, unless the parameters.xml of 

the data file indicate sthe following: 

<PublishMethod>AutoAcceptStagingData</PublishMethod> 

 

 

o AutoImport: Databestand wordt ingelezen en verwerkt. Een rapport wordt 

verstuurd naar het e-mail adres dat is aangegeven in de parameters.xml van 

het databestand. 

• The data processing via FTPS is automated. 

 
When importing industry standard data into your own assortment, please consider the following: 
 

This is only possible for the PAB, INSBOU and DICO/SALES data file types. A parameters.xml 
can be added manually to the BMEcat zip file containing the following code: 
 
<?xml version="1.0" encoding="utf-8"?><UCProcessParameters 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns="http://www.2ba.nl"><<PublishMethod>AutoAcceptStagingData</Pub
lishMethod><ReportAllCheckDetailMessages>false</ReportAllCheckDetail
Messages><SendReportToEmail>mijn-
email@adres.com</SendReportToEmail><ReportLanguage 
/></UCProcessParameters> 
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• Imports of industry standard data cannot be scheduled through Periodic Tasks 
• Data files placed within folders AutoImport/AutoCheck will be processed within the 

hour. 
• The Global Location Number (GLN) in the offered industry standard data file will be 

compared with the GLNs of existing assortments: 
o In the event of a match, you will receive a report in which existing data has 

been compared with supplied data (when placed in AutoCheck folder), or the 
existing assortment will be updated (data placed in or moved to AutoImport 
folder). 

o When there is no match, manufacturer(s), supplier and assortment entries are 
created on the basis of the supplied data file and filled out with the relevant 
new data. When the data file is placed in the AutoCheck folder, you will receive 
an import analysis report indicating that these entities will be created on 
import. When the data file is placed in the AutoImport folder, these entities 
are created directly. 

 
Note: Failed and processed folders will be automatically created for all folders used for an Import. 
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14 Appendix B: Unit definitions 

14.1 Units 

Price unit (PU), often combined with Price quantity (PQ): Unit on which the gross price is based. 
 

Example 
When a price is set per Price quantity, these units have to be set as follows: 

• Price per m2: PH = 1, PE = m2 
• Price per 100 m2: PH = 100, PE = m2 
 

Important: When the unit is PIECE (PCE), there is sometimes confusion whether pieces is 
intended as Items or Boxes. However, Piece is always meant to indicate an Item, never any other 
unit, such as Length, Box, Roll etc. 
 
Order unit (OU): Unit in which the item is ordered. This can be piece, m2, m, etc. 
Calculation unit (CU): Unit used to calculate with this article. This can be a somewhat difficult unit 
for suppliers to determine. But often also piece, m2, m, etc. 
 
Packaging form: Unit for packaging of the Item, for instance: Box, Roll, Bucket, etc. When 
not known or not packaged, then Unpackaged can be used. 

14.2 Ratios 

Furthermore, a number of ratios are important: 
 
Number of PU per OU: The number of Price units per Order unit. 
 

Example 
Suppose an insulation board is ordered per plate (pieces), the price unit is m2 and the size of 
the plate is 1000 x 1200 mm = 1.2 m2. The number of PU (m2) per OU (pieces) is then 
1.2 
 

Number of CU per OU: The number of Calculation units per Order unit. 
 

Example 
Suppose an insulation board is ordered per plate (pieces), the calculation unit is m2 and the 
size of the plate is 1000 x 1200 mm = 1.2 m2. The number of CU (m2) per OU (pieces) is 
then 1.2 

14.3 Other variables 

Minimum order quantity: The minimum purchase expressed in number of order units. This can, 
for example, be set to 10 if a supplier always has to take at least 10 rolls of roofing material. 
 
Step size: The step size expressed in number of order units. 
 

Example 
When step size is set to 5, orders always have to be in quantities of five (15, 20, 25, etc). 
In practice, it is recommended to keep it the same as the minimum order quantity. 
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